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Úvod 

Všeobecné postupy pri vytváraní integrovaných kníh 

Tvorba integrovanej knihy  / knihy vo formáte Daisy  pozostáva z 5 kľúčových krokov. V tomto manuáli 

budeme hovoriť o vytváraní knihy vo formáte Daisy z prístupného Word dokumentu .  Jednotlivé kroky 

tvorby sú: 

1. Tvorba prístupného Word  a / alebo PDF dokumentu  

2. Používanie  Central Access Reader (CAR) na čítanie prístupného Word dokumentu  

3. Tvorba MP3 súboru z prístupného Word dokumentu použitím Central Access Reader (tento 

používa syntetický hlas) 

4. Konverzia prístupného dokumentu na  DAISY e-knihu 

5. Tvorba  prístupnej Daisy e-knihy použitím Tobi s nahrávkou ľudského hlasu 

Každý z týchto krokov bude v tomto manuáli  opísaný do určitej miery . Obsahuje skúsenosti partnerov  s 

tvorbou prístupných kníh , video a linky s popisom.  

Tento materiál tiež obsahuje kroky potrebné pre tvorbu integrovaných kníh z tlačených učebníc, e-kníh a 

iných formátov.  
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Tvorba prístupného dokumentu pre ľudí s problémami čítania 

Osvedčené postupy pri tvorbe prístupného Word formátu 

Kontrola zjednodušeného ovládania dokumentu 

Pre revíziu obsahu materiálu a označenie problémov so zjednodušeným ovládaním  je potrebné 

používať  kontrolu zjednodušeného ovládania , ktorá vysvetľuje, aké  problémy jednotlivé chyby 

môžu predstavovať pre ľudí so znevýhodnením.  Kontrola zjednodušeného ovládania tiež 

obsahuje návrhy pre riešenie jednotlivých chýb / problémov. 

Ako možno vidieť na obrázku nižšie, funkciu Kontroly zjednodušeného ovládania ktorá ukazuje 

problémy s prístupnosťou dokumentu počas práce s ním môžeme nájsť pod panelom hlavého 

menu 

 

Vo formáte Word  je Kontrola zjednodušeného ovládania počas tvorby dokumentu automaticky 

spustená  na pozadí . 

Obmedzenie používania tabuliek 

Vo všeobecnosti by  sa pri tvorbe prístupných materiálov mali tabuľky používať len v prípade, ak 

je to nevyhnutné. Najlepším spôsobom prezentácie informácií je celistvý , prepojený text , ktorý 

obsahuje nadpisy a záhlavia. Ľudia, ktorí používajú na čítanie tabuliek lupu , vnímajú tabuľky 

s prednastavenou šírkou ťažko čitateľnými , keďže pri ich používaní je obsah vtesnaný na určený 

rozmer. To znamená, že písmo je veľmi malé a používatelia lupy musia pri čítaní  text 

prechádzať horizontálne.  Tento problém je ešte výraznejší pri čítaní na mobilných zariadeniach. 
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Ak je použitie tabuľky nevyhnutné , je potrebné postupovať podľa nasledujúcich krokov: 

▪ Vyhnite sa tabuľkám s prednastavenou šírkou 

▪ Používajte kontrolu mobilných zariadení , aby ste sa uistili, že tabuľky sa zobrazujú 

správne na všetkých zariadeniach , vrátane smartfónov a tabletov. 

▪ Ak tabuľka obsahuje hypertextové prepojenia, zjednodušte ich editovaním textu 

týchto prepojení  a uistite sa, že sú kompletné.  

Používanie nadpisov v tabuľkách 

Čítačky zaznamenávajú svoju pozíciu v tabuľke počítaním buniek tabuľky. Ak je tabuľka vnorená 

do inej tabuľky, alebo je tabuľka zlúčená či rozdelená, čítačka nemôže ďalej počítať bunky a od 

tohto miesta ďalej nemôže poskytovať vhodné informácie o tabuľke. Prázdne bunky v tabuľke 

môžu byť pre používateľa tiež mätúce , keďže si môže myslieť, že ďalšie informácie sa v tabuľke 

už nenachádzajú. Používajte jednoduchú štruktúru tabuliek výhradne pre dáta a špecifikujte 

informácie  v kolónke pre názov stĺpca. Používatelia čítačiek  používajú  aj informácie v nadpise  

 

Používanie prednastaveného nadpisu, podnadpisu a štýlov 

Nadpis, Podnadpis, a štýly sú vytvárané tak, aby ich bolo možné skenovať vizuálne ako aj s 

použitím podporných technológií. Používajte prednastavený  štýl pre Nadpis a Podnadpis   pre 

nadpis a podnadpis dokumentu. 

V ideálnom prípade použité štýly naznačujú, o čom je konkrétna časť dokumentu. Pre uľahčenie 

čitateľom vnímať štruktúru dokumentu a orientovať sa v štýloch používajte prednastavené štýly 

a vytvorte opisné texty v nadpisoch  

Zoraďte štýly v logickom poradí  a nepreskakujte úrovne  štýlov. Napríklad, použite Nadpis 1, 

Nadpis 2 a potom Nadpis 3 ,namiesto  Nadpis 3, Nadpis 1 a potom Nadpis 2. Rozdeľte 
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informácie vo vašom dokumente do krátkych častí . V ideálnom prípade bude pod každým 

nadpisom len zopár odsekov.  

Označenie nadpisu odseku 

Pri práci s dokumentom, ktorý sa neviaže k vydanej učebnici môžete tiež vytvoriť nadpis odseku. 

V  nadpise odseku sa farebný blok pozadia rozšíri na celú šírku dokumentu a zvýrazní text vo 

vnútri  časti s nadpisom.  Tento spôsob je výbornou alternatívou k tabuľkám, na organizáciu a 

oddeľovanie obsahu.  

Pridanie alternatívneho textu k vizuálnemu 

obsahu 

Alternatívny text pomáha ľuďom, ktorí nevidia obrazovku aby porozumeli ,čo je dôležité vo 

vizuálom obsahu. Vizuálny obsah zahŕňa obrázky, grafické prvky SmartArt, tvary, skupiny, grafy, 

vložené objekty, farbu, a videá. V alternatívnom texte stručne opíšte obrázok a uveďte jeho 

účel. Čítačky tento text prečítajú, aby opísali obrázok pre používateľov, ktorí  tento obrázok 

nevidia. 

Vyhnite sa používaniu textu v opise obrázka ako jediného spôsobu sprostredkovania dôležitých 

informácií. Ak obrázok s textom musíte použiť, opakujte tento text aj v dokumente. V 

alternatívnom texte stručne popíšte obrázok a uveďte prítomnosť textu a jeho účel. 

Alternatívny text by nemal byť dlhší ako jedna alebo dve vety- vo väčšine prípadov bude stačiť  

zopár vhodne zvolených slov. Neopakujte už použitý textový obsah na opis obrázkov a pri opise 

obrázkov nepoužívajte frázy ako  ´grafické znázornenie´ alebo ´obrázok´  . 

Na vyhľadanie chýbajúceho textu pre opis obrázka použite Kontrolu zjednodušeného ovládania. 
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Pridanie hypertextového prepojenia a funkcie 

ScreenTips 

Ľudia, ktorí používajú čítačky niekedy skenujú zoznam obsiahnutých hypertextových prepojení.  

Prepojenia by mali sprostredkovať jasné a presné informácie o zdroji.  Napríklad, vyhnite sa 

používaniu textu ako ´´ ´Tu kliknite´ alebo ´Pozri túto stranu´, ´ Prejdi na´ alebo ´Viac informácií´. 

Namiesto nich uveďte celý nadpis stránky použitého  zdroja.  Môžete tiež pridať aj funkciu 

ScreenTips , ktorá sa zobrazí pri podržaní kurzora na texte alebo obrázkoch , ktoré obsahujú 

hypertextové prepojenie.   

Použite prístupného formátu a farby písma 
 

Prístupné písmo nevylučuje ani nespomaluje rýchlosť čítania nikoho, kto číta dokument, 

vrátane slabozrakých alebo nevidiacich ľudí. Správne zvolené písmo zlepšuje čitateľnosť 

dokumentu. 

Použitie prístupného formátu písma 

Niekoľko užitočných nápadov: 

• Ak chcete zjednodušiť čítanie, vyberte známe bezpätkové písma, ako napríklad Arial 

alebo Calibri. Nepoužívajte všade veľké písmená a nadmernú kurzívu alebo 

podčiarknutie. 

• Osoba so zrakovým postihnutím nemusí rozoznávať význam jednotlivých farieb. Pridajte 

napríklad podčiarknutie do farebne označeného textu hypertextového odkazu, aby 

farboslepí ľudia vedeli, že text je prepojený, aj keď nevidia farbu. 

• V prípade nadpisov zvážte pridanie tučného písma alebo použitie väčšieho písma. 

• Pridajte tvary, ak sa na označenie správnosti používa farba. Napríklad pridajte symbol 

začiarknutia , ak sa zelená používa na označenie „vyhovuje“, a veľké písmeno X

, ak červená označuje „nevyhovuje“. 
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Použitie prístupného formátu písma 

Text vo vašom dokumente by mal byť čitateľný s vuužitím vysokého kontrastu farby. Použite 

napríklad jasné farby alebo vysoko kontrastné farebné odtiene na opačných koncoch farebného 

spektra. Biele a čierne schémy uľahčujú farboslepým ľuďom rozlišovanie textu a tvarov. 

Niekoľko užitočných nápadov: 

• Ak chcete zabezpečiť, aby sa text zobrazoval dobre v režime vysokého kontrastu, použite 

pre farby písma nastavenie Automaticky. 

• Pomocou nástroja Accessibility Checker analyzujte dokument a nájdite dostatočný 

farebný kontrast. Nástroj v dokumentoch kontroluje farbu textu podľa farby strany, 

pozadia buniek tabuľky, zvýraznenia, farby výplne textového poľa, tieňovania odsekov, 

tvarov a výplní SmartArt, hlavičky, päty a odkazov. 

• Použite Color Contrast Analyser, bezplatnú aplikáciu, ktorá analyzuje farby a kontrast a 

zobrazí výsledky takmer okamžite. 

 

Vytváranie prístupných dokumentov 

Aby ste uľahčili čitateľom čítanie dokumentu na obrazovke, tak usporiadajte informácie v 

dokumente do malých častí, ako sú napríklad zoznamy s odrážkami alebo očíslované zoznamy. 

Navrhnite zoznamy tak, aby ste do stredu zoznamu nemuseli pridávať obyčajný odsek bez 

odrážky alebo čísla. Ak je váš zoznam rozdelený na obyčajný odsek, niektoré čítačky obrazovky 

môžu oznámiť nesprávny počet položiek zoznamu. Používateľ tiež môže v strede zoznamu 

počuť, že opúšťa dokument. 
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Pridanie medzier medzi vetami a odsekami 

 

Ľudia niekedy popisujú, že sa im na stránke zobrazuje text „splývajúci spolu“ (stlačenie jedného 

riadku textu do riadku nižšie). Často vidia, že sa text spája alebo deformuje. Ak chcete znížiť 

zaťaženie čítania, môžete zväčšiť medzery medzi vetami a odsekmi. Vždy však majte na pamäti, 

že musíte zabezpečiť, aby číslovanie strán bolo konzistentné medzi knihou (ak pracujete z knihy) 

a dokumentom vytvoreným z knihy. 

 

Otestovanie prístupnosti pomocou “Immersive Reader” (imerzná čítačka) 

Skús čítať document s Immersive Reader pre vyskúšanie ako znie zvuk k textu: 

1. V dokumente zvoľ View > Immersive Reader. 

2. Z Immersive Reader tabuľky vyber Read Aloud. 

3. Pre opustenie Immersive Reader zvoľ Close Immersive Reader. 

 

Konvertovanie PDF formátu do textového formátu 

Na vytvorenie knihy v Daisy formáte je najvhodnejšie pripraviť si texty prílsušnej knihy v súbore 

Microsoft word. Ak sa vám podarí získať knihu v Microsoft word formáte, môžete začať s 

vytváranaím prístupného textového dokumentu. V mnohých prípadoch však môže byť 

problematické dopracovať sa k materiálu v súbore programu Word. Vydavatelia zvyčajne 

poskytujú rôzne iné formáty knihy, ako napr.: 

- naskenovaný PDF súbor (pdf súbor, v ktorom sú strany naskenované ako obrázky);  

- PDF súbor (pdf súbor vytvorený / exportovaný z word dokumentu);   

- samotný výtlačok knihy / publikácie.  

Pvrým krokom je teda prevedenie akéhokoľvek formátu knihy / súboru na dokument programu 

Word, aby sme mohli pristúpiť k vytváraniu prístupného textového dokumentu.   



11 
 

Tu je niekoľko dostupných možností podľa toho, aký druh pracovného súboru máte. 

 

Konvertovanie skenovaného PDF do Word 

V prípade, keď máte súbor vo formáte naskenovaného pdf, najjednoduchší spôsob prevedenia 

tohto súboru do Word dokumentu je použitie funkcie Google Docs OCR (Optické rospoznávanie 

znakov / Optical Character Recognition).  

Váš email na Googli obsahuje Google Drive (virtuálny disk), kde si môžete svoje dokumenty 

ukladať, upravovať aj zdieľať. Súbor PDF môžete previesť do programu Microsoft Word 

vytvorením OCR pomocou troch jednoduchých krokov: 

Krok 1: Prihláste sa do svojho Google/Gmail účtu. Kliknite na My Drive. Nahrajte súbor, ktorý 

chcete konvertovať. 
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Krok 2: Keď súbor nahráte, nájdete ho v záložke My Drive. Kliknite na súbor, ktorý chcete 

konvertovať a zvoľte Open with Google Doc. 

 

Krok 3: Keď tento dokument otvoríte, automaticky sa vám otvorí ako word dokument, a môžete 

si ho aj uložiť na svoj lokálny drive ako Microsoft Word dokument. Choďte na Súbor/File – 

Vyberte Stiahnuť/Download – Zvoľte Microsoft Word (.docx).  
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Po uložení súboru vo formáte Microsoft Word môžete pokračovať v ďalších úpravách 

dokumentu, ktoré sú potrebné k vytvoreniu prístupného elektronického dokumentu. Uistite sa, 

že konvertovaný Word dokument obsahuje všetko, čo sa nachádza v origináli. Niekedy sa môže 

stať, že vytvorený dokument má chybný font v niektorých slovách, zmenené riadkovanie, 

vynechané slová a pod.  

Taktiež tu existuje priestorové obmedzenie, čo sa týka rozsahu uloženého dokumentu. Pri 

neplatenom Google Drive je možné konvertovať 15 strán alebo 2MB. Pri platenom Google 

business účte môžete konvertovať aj väčšie súbory.  

 
 

 

Konvertovanie jednoduchého PDF do Word 
 

Ak máte k dispozícii jednoduchý súbor PDF (dokument Word uložený ako PDF) a chcete ho 

znova previesť na Word, môžete použiť spôsob prevedený v Google Drive opísaný vyššie. Ďalšou 

možnosťou je konvertovanie súboru PDF do Word využitím softvéru Acrobat Pro. Tento 
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aplikačný softvér je spoplatnený a umožňuje vytvárať a upravovať súbory PDF. V tomto softvéri 

je možné importovať a exportovať aj iné formáty vrátane Excelu, Power Pointu atď. 

 

Na snímke obrazovky hore vidíme ako sa konvertuje pdf súbor do Word dokumentu v 

aplikačnom softvéri Adobe.  

1. Otvor Adobe Acrobat Pro 

2. Otvor PDF súbor, ktorý chceš konvertovať 

3. Označ možnosť Adobe Export PDF  

4. Vyber Convert to Microsoft Word (*doc.) 

5. Potvrď modrým políčkom - Convert 

Následne môžete otvoriť konvertovaný Word dokument, v ktorom je zachovaná štruktúra a 

formátovanie originálneho pdf dokumentu. Odporúča sa skontrolovať celý document a uistiť sa, 

že všetko je na svojom mieste.  
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PDF do Word formátu použitím online softvéru 
 

Ďalším spôsobom prevodu súboru PDF na document program Word je použitie online aplikácií, 

ktoré umožňujú rýchlu a okamžitú konverziu. Konverzia v takom prípade nie je vždy v najlepšej 

kvalite, preto sa opäť odporúča skontrolovať verziu vytvoreného Word dokumentu.  

Odporúčané webové stránky, ktoré dokážu konvertovať PDF do Word sú napríklad 

ilovepdf.com, smallpdf.com, pdf2doc.com, freepdfconvert.com. Všetky tieto stránky vás 

požiadajú, aby ste na stránku nahrali svoj PDF document a následne si môžete stiahnuť svoj 

nový document vo Word formáte. 

Nižšie je ukážka konverzie cez webovú aplikáciu ilovepdf.com: 

 

Krok 1: Choď na webovú stránku, zvoľ možnosť PDF to Word.
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Krok 2: Klikni na Vyber/Select PDF File/súbor a nahraj súbor, ktorý chceš konvertovať do Word 

dokumentu.  

 

Krok 3: Vyber/Select možnosť Convert to Word a počkaj kým sa dokument konvertuje. 
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Krok 4: Vyber Download Word version a zvoľ miesto v počítači na uloženie vytvoreného 

dokumentu.  
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Synchronizácia zvuku a textu 
 

Jednotilivé audio nahrávky kapitol potrebujeme uložiť v mp3 formáte predtým, ako ich budeme 

priraďovať k textovej stope. Zároveň si každú nahratú stopu vypočujeme, vymažeme chyby, 

odchýlky upravíme a vyčistíme. Je praktické pomenovať každú nahrávku číslom kapitoly alebo 

stranami v knihe, ktoré obsahuje. Ušetrí nám to veľa času a uľahčí prácu pri manipulácii 

s veľkým množstvom mp3 stôp.  

 

 

 

 

How to delete muttering noises and any other disruptive rustle. 

Ako zredukovať šum v nahrávke 

Predtým ako začneme synchronizačný proces, potrebujeme nastaviť niektoré audio funkcie, aby 

sme nahrávku vyčistili a zlepšili jej kvalitu. Postupujte takto: 

1. Importujte prvú časť mp3 nahrávky do Tobi a označte úplný začiatok audio stopy / 

zvukovej vlny.  

2. Potom otvorte Efekt na kontroInom paneli a kliknite na Redukcia šumu.  
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3. V okne s názvom Redukcia šumu označte tlačidlo Získať profil šumu a potvrďte OK. 

 
4. Označte celú stopu [Ctrl+A] potom opäť Efekt – Redukcia šumu – zadajte 18 v redukcia 

šumu a stlačte OK. 
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Vkladanie a delenie audio obsahu 

 

Sú dva spôsoby ako vložiť audio do Tobi: 

1. Importovať audio súbor a rozdeliť ho do kratších častí, ktoré kopírujú označený text. 

2. Nahrať zvukové stopy priamo v programe Tobi.  

Druhá možnosť môže trvať oveľa dlhšie, keďže každá stopa musí byť v čase nahrávania 

´dokonalá´, t.j. čistá a upravená. Ak nahrávame s profesionálnym hercom, môže to byť finančne 

náročnejšie.  

Budeme sa teda zaoberať tým, ako importovať vopred nahratý mp3 formát a následne ho 

rozdeliť, a prideliť k príslušnému textu.  

1. Otvorte text v Tobi. 

 

2. Importujte nahranú audio stopu – MP3 súbor.  

Ak chcete označiť polohu kurzora na zvukovej vlne: 
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• Myškou jednoducho kliknite na dané miesto zvukovej vlny.  

• Na klávesnici použijeme na prehranie zvuku medzerník a v mieste, kde chceme 

zvukovú stopu pozastaviť / označiť / oddeliť, opätovne stlačíme medzerník.  

3. Tobi zobrazí každú označenú stopu v tmavšej farbe na paneli Audio editor. Ak si chcete 

vypočuť obsah svojho výberu, stlačte medzerník. Ak je označený výber zvuku, príkaz 

„Prehrať“ prehrá len zvukový obsah výberu. 

 

4. Označte časť textu, ku ktorému chcete pripojiť zvuk. Text, ktorý budete synchronizovať 

so zvukom je teraz označený a farebne zvýraznený. Nahrávku spustíme pomocou tlačidla 

„Auto play“ alebo stlačením medzerníka, a následne ju musíme oddeliť od zvyšnej stopy.  

 

5. Zvukový obsah môžeme rozdeliť buď označením pozície kurzora alebo za behu počas 

prehrávania. Príkaz na rozdelenie môžete vykonať kliknutím na položku Audio – Split 

audio  v ponuke, alebo stlačením [CTRL+Enter], čím sa zvyšok zvuku automaticky 

presunie na ďalšiu dostupnú textovú frázu. Tento príkaz je veľmi užitočný, keď máme 

k dispozícii vopred nahraný zvukový obsah a chceme ho zosúladiť s jeho textovým 

ekvivalentom. Medzerník a Ctrl+Enter  sa používajú opakovane, kým nie je celý zvukový 

obsah zosynchronizovaný, respektíve pridelený k jednotlivým textovým frázam, či 

odsekom.  

 

6. Rýchlosť prehrávania môžeme zvýšiť, aby bol proces synchronizácie rýchlejší, alebo ju 

môžeme spomaliť tam, kde je to potrebné. Tieto príkazy na ovládanie rýchlosti zvuku 

nájdete v Audio preferences/Predvoľby zvuku v ponuke Audio menu. Tobi má 

nastavený špecifický rozsah rýchlosti pre príkazy „Zosilniť“, „Zrýchliť“ a „Spomaliť“ – tie 

môžu byť upravené tak, aby vyhovovali vašim požiadavkám.  

• Spomaliť / Slow down — Natiahne zvukovú vlnu tak, že zvuk je prehrávaný pomalšie. 
• Zrýchliť / Speep up — Skráti zvukovú vlnu v ovládacom paneli tak, že prehrávaný zvuk 

má väčšiu rýchlosť.  
• Normalizovať / Normalize — Vykoná normalizáciu zvuku na označenej/vybratej zvukovej 

stope.  
• Zosilniť/Amplify—Zintenzívňuje zvukový obsah, aby bol počuteľnejší.  

 

7. Na kontrolu správnosti synchronizácie použite tlačidlá ‚predchádzajúci‘(previous) a 

‚nasledujúci‘ (next). 

 

8. Na odstránenie nechceného ´ticha´ na začiatku vety vyberte zvukovú vlnu ticha presne 

tak, ako vyberáte/značíte text predtým, ako ho chcete vymazať alebo kopírovať. Potom 
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stlačte [DELETE]. Vymažete len označenú časť zvukovej vlny v Tobi. Po označení 

zvukovej vlny ju môžete vymazať tiež stlačením Audio->Delete selected audio v ponuke, 

stlačením Del, alebo stlačením tlačidla Delete selected audio v Zvukovom ovládacom 

paneli. Zvuková stopa, ktorú vymažete nebude fyzicky odstránená zo súboru, iba sa zruší 

prepojenie s projektom.  

 

9. Vystrihnite, Skopírujte a Prilepte 

Na vybranom zvuku je možné vykonať nasledujúce príkazy: 

• Ak chcete skopírovať výber zvuku do schránky, kliknite na Edit->Copy v ponuke, 

stlačte Ctrl+C, alebo použite tlačidlo Copy v hlavnom paneli nástrojov. 

• Ak chcete vystrihnúť výber zvuku a skopírovať ho do schránky, kliknite na Edit->Cut v 

ponuke, stlačte Ctrl+X, alebo použite tlačidlo Cut v hlavnom paneli nástrojov. 

• Ak chcete prilepiť zvukovú položku zo schránky do zvukovej stopy v určitom mieste, 

kliknite na Edit->Paste v ponuke, stlačte Ctrl+V, alebo použite tlačidlo Paste v hlavnom 

paneli nástrojov.  

Tobi vloží zvukový obsah zo schránky podľa nasledujúcih pravidiel: 

• Ak je označený výber zvuku, zvukový obsah zo schránky nahradí výber zvuku. 

• Ak označíte pozíciu kurzora, zvukový obsah sa vloží na toto miesto. 

• Ak nie je nič označené, zvuk sa prilepí pred akýkoľvek zvukový obsah, ktorý už je 

importovaný v zvukovom paneli.  

• Ak ste na konci zvukovej stopy/vlny (audio bolo vypočuté a zastavené – pozícia kurzora 

je na konci), zvukový obsah sa prilepí za koniec akéhokoľvek zvukového obsahu. 

• Ak označená textová fráza nemá zodpovedajúci zvuk, zvukový obsah zo schránky sa s 

ňou zosynchonizuje.  

 

 

 

 


